
Guide du débutant

Chapitre 9
Débuter avec Math
L’éditeur de formule (équation) de LibreOffice 





Droits d’auteur

Ce  document  est  protégé  par  Copyright  © 2012–2016  par  l’Équipe  de  Documentation  de
LibreOffice. Les contributeurs sont nommés ci-dessous. Vous pouvez le distribuer et/ou le modifier
sous les termes de la Licence Publique Générale GNU(http://www.gnu.org/licenses/gpl.html), ver-
sion 3 ou ultérieure, ou de la Licence Creative Commons Attribution (http://creativecommons.org/li-
censes/by/4.0/), version 4.0 ou ultérieure.

Toutes les marques déposées citées dans ce guide appartiennent à leurs légitimes propriétaires.

Contributeurs
Jean Hollis Weber Hazel Russman Laurent Balland-Poirier
John A Smith Martin Saffron Peter Schofield
Olivier Hallot

Traducteur
Jean-Luc Vandemeulebroucke

Relecteurs : Laurent Balland-Poirier

Retours
Veuillez adresser tout commentaire ou suggestion concernant ce document à la liste de diffusion
de l’Équipe de Documentation : doc@fr.libreoffice.org

Remarque : tout ce que vous envoyez à la liste de diffusion, y compris votre adresse mail et toute
autre information personnelle incluse dans le message, est archivé publiquement et ne peut pas
être effacé.

Remerciements
Ce document est basé OpenOffice.org 3.3 Math Guide. Les contributeurs de ce livre sont :

Daniel Carrera Agnes Belzunce TJ Frazier
Peter Kupfer Ian Laurenson Janet M. Swisher
Jean Hollis Weber Michele Zarri

Certains éléments supplémentaires ont été ajoutés depuis le Math Handbuch for LibreOffice 3.4 en
allemand (traduit en anglais par Hazel Russman). Ont apporté leur contribution à ce livre :

Regina Henschel Christian Kühl Florian Reisinger
Gisbert Friege (Dmaths) Jochen Schiffers

D’autres éléments supplémentaire ont été ajoutés à partir de How-To Math for LibreOffice en fran-
çais (traduit en anglais par Laurent Balland-Poirier). Bernard Siaud et Frédéric Parrenin ont contri-
bué à ce livre.

Date de publication et version du logiciel
Publié le 1 mars 2017. Basé sur LibreOffice 5.1.

Les captures d’écran sont effectuées sous Windows 10 avec le jeu d’icônes Galaxy.

La documentation française de LibreOffice est disponible à
https://wiki.documentfoundation.org/Documentation/Publications/fr

mailto:doc@fr.libreoffice.org
http://creativecommons.org/licenses/by/4.0/
http://creativecommons.org/licenses/by/4.0/
http://www.gnu.org/licenses/gpl.html


Utiliser LibreOffice sur un Mac

Sur Mac, certaines touches et certains éléments de menu sont différents de ceux utilisés sous
Windows ou Linux. Le tableau ci-dessous donne quelques substitutions courantes pour les instruc-
tions de ce chapitre. Pour une liste plus détaillée, voyez l’Aide de l’application.

Windows ou Linux Équivalent Mac Effet

Sélection du menu 
Outils > Options

LibreOffice > Préférences Accès aux options de configuration

Clic droit Control+clic ou clic droit 
selon la configuration de 
l’ordinateur

Ouvre un menu contextuel

Ctrl (Control) ⌘ (Command) Utilisé avec d’autres touches

F5 Shift+⌘+F5 Ouvre le Navigateur

F11 ⌘+T Ouvre la fenêtre Styles et Formatage

La documentation française de LibreOffice est disponible à
https://wiki.documentfoundation.org/Documentation/Publications/fr
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Introduction

LibreOffice Math est un éditeur de formule que vous pouvez utiliser pour créer ou modifier des for-
mules  (équations)  sous  une  forme symbolique  à  l’intérieur  des  documents  de  LibreOffice  ou
comme objets indépendants. Des exemples de formules sont proposés ci-dessous. Cependant, si
vous désirez calculer des valeurs numériques à partir de formules, reportez-vous au  Guide de
Calc pour plus d’informations : Math n’effectue aucun calcul.

df (x)
dx

=ln (x)+tan−1(x2) ou NH3+H2O→NH4
++OH −

Dans Math, l’Éditeur de Formule utilise un langage de balisage pour représenter les formules. Ce
langage est conçu pour être aussi facile à lire que possible ; par exemple a over b donne la frac-

tion 
a
b

 dans une formule.

Débuter

Grâce à l’Éditeur de Formule, vous pouvez créer une formule sous forme de document indépen-
dant (ou fichier de bibliothèque de formules) ou insérer directement les formules dans un docu-
ment créé avec LibreOffice Writer, Calc, Impress ou Draw.

Les formules dans les documents de LibreOffice
Pour insérer une formule dans un document de LibreOffice, ouvrez ce document dans Writer, Calc,
Draw ou Impress. La façon dont vous allez positionner le curseur pour insérer la formule dépend
du module de LibreOffice ouvert.

• Dans Writer, cliquez dans le paragraphe où vous désirez insérer la formule.
• Dans Calc, cliquez dans la cellule où vous désirez insérer la formule.
• Dans Draw et Impress, la formule est insérée au centre du dessin ou de la diapositive.

Allez ensuite à Insertion > Objet > Formule dans la barre de menu pour ouvrir l’Éditeur de for-
mule. Vous pouvez aussi aller à Insertion > Objet > Objet OLE dans la barre de menu pour ouvrir
la boîte de dialogue Insérer un objet OLE, sélectionner l’option Créer un nouvel objet puis For-
mule dans la liste. Cliquez ensuite sur OK pour ouvrir l’Éditeur de formule. Le Volet des éléments,
à gauche de la Fenêtre d’aperçu peut aussi apparaître, s’il a été coché dans Affichage depuis la
barre de menu. Pour plus d’information sur la création de formules, voir « Créer des formules »
page 9.

La Figure 1 montre un exemple de document Writer avec la boîte de formule sélectionnée en at-
tente de la saisie de cette formule. À mesure que vous saisissez le langage de balisage dans l’Édi-
teur de Formule, celle-ci apparaît dans la Fenêtre d’aperçu pendant et après la saisie.

Quand vous avez fini de saisir le code de balisage de la formule, refermez l’Éditeur de Formule en
appuyant sur la touche Échap ou en cliquant hors de la formule dans le document. Un double clic
sur l’objet formule dans le document ouvrira de nouveau l’Éditeur de Formule où vous pourrez la
modifier.

Les formules sont insérées dans les documents comme objets OLE. Comme pour tous ces objets,
vous pouvez modifier l’emplacement de celui-ci dans le document. Pour plus d’informations sur les
objets OLE, voyez les guides de l’utilisateur de Math, Writer, Calc, Draw et Impress.

Si vous insérez souvent des formules dans des documents, vous pouvez ajouter le bouton For-

mule  à la barre d’outils Standard ou créer un raccourci au clavier. Voyez le chapitre 14, Per-

sonnaliser LibreOffice pour plus d’informations.
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Figure 1 : Formule vide dans un document Writer

Conseil
Si l’aperçu est trop petit ou trop gros, vous pouvez modifier simplement le zoom en
maintenant la touche Ctrl enfoncée et en faisant tourner la molette de la souris ou en
faisant glisser la barre de zoom en bas à droite de la fenêtre.

Les formules en tant que documents indépendants
Pour créer une formule en tant que document indépendant, utilisez une des méthodes suivantes
pour ouvrir un document vide dans LibreOffice Math (Figure 2) :

• Sur la barre de menu, allez à Fichier > Nouveau > Formule.
• Depuis le Centre de Démarrage, cliquez sur Formule Math.

• Sur la barre d’outils Standard, cliquez sur le triangle à droite de l’icône Nouveau  et

choisissez Formule dans le menu déroulant.
• Dans Math, utilisez les touches de raccourci Ctrl+N.
• Utilisez la commande Importer MathML depuis le presse-papier.

 Comme pour l’édition de formules dans les modules Writer, Calc, Draw et Impress, le Volet des
éléments peut aussi apparaître à gauche de la Fenêtre d’aperçu, s’il a été coché dans Affichage
dans la barre de menu. Pour plus d’information sur la création de formules, voyez « Créer des for-
mules » page 9.
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Figure 2 : Un document Formule vide dans Math

Créer des formules

Vous pouvez insérer des éléments dans une formule en utilisant une des méthodes suivantes :

• Choisissez une catégorie dans la liste déroulante puis un symbole dans le Volet des élé-
ments.

• Faites un clic droit dans l’Éditeur de Formule et choisissez une catégorie puis un symbole
dans le menu contextuel.

• Saisissez directement le langage de balisage dans l’Éditeur de Formule.

Remarque
L’utilisation du Volet des éléments ou des menus contextuels pour créer une formule
offre un moyen pratique et efficace pour apprendre le langage de balisage utilisé par
LibreOffice Math.

Le Volet des éléments
Le Volet des éléments peut servir à saisir facilement les données d’une formule. En plus de la liste
des  catégories  en  haut  de  la  fenêtre,  il  offre  aussi  une  catégorie  Exemples  contenant  des
exemples utilisables comme points de départ de formules ou d’équations.

 1) Allez à Affichage dans la barre de menu et cochez Éléments pour ouvrir le Volet des élé-
ments (Figure 3) s’il n’est pas visible.

 2) Choisissez la catégorie souhaitée dans la liste déroulante en haut du Volet des éléments.
 3) Choisissez le symbole que vous désirez utiliser  dans la formule dans le  Volet  des élé-

ments. Les symboles disponibles dépendent de la catégorie choisie.
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Figure 3 : Le Volet des Éléments

Remarque
Le Volet des éléments est positionné par défaut à gauche des fenêtres d’Aperçu et de
l’Éditeur de Formule comme on le voit sur la Figure 1 et la Figure 2. Il peut être désarri-
mé et rendu flottant de la même façon que les autres fenêtres fixées.

Le menu contextuel

Figure 4 : Le menu contextuel de l’Éditeur de Formule

L’Éditeur de Formule propose aussi un menu contextuel qui permet d’accéder aux catégories et
symboles nécessaires à la création d’une formule. Un clic droit dans l’Éditeur de Formule ouvre ce
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menu. Choisissez une catégorie puis un exemple de code de balisage que vous désirez utiliser
dans le sous-menu. La Figure 4 montre un exemple.

Remarque
Le Volet des éléments et le menu contextuel ne proposent que les commandes les plus
couramment utilisées dans les formules. Pour les commandes d’utilisation plus rare,
vous devez toujours les saisir en utilisant le langage de balisage. Pour une liste com-
plète des commandes, voyez le Guide de Math.

Le langage de balisage
Le  langage  de  balisage  est  saisi  directement  dans  l’Éditeur  de  Formule.  Par  exemple,  taper
5 times 4 dans l’Éditeur de Formule crée la formule 5×4 . Avec de l’expérience, cela peut de-
venir le moyen le plus rapide pour saisir une formule. Le  Tableau 1 montre quelques exemples
d’utilisation du langage de balisage pour saisir des commandes. Pour une liste complète des com-
mandes utilisables dans l’Éditeur d’équation, voyez le Guide de Math.

Tableau 1 : Exemples de commande qui utilisent le langage de balisage

Affichage Commande Affichage Commande

a=b a = b √a sqrt {a}

a2 a^2 an a_n

∫ f (x)dx int f(x) dx ∑ an sum a_n

a≤b a <= b ∞ infinity

a×b a times b x⋅y x cdot y

Lettres grecques

Avec le langage de balisage
Les lettres grecques sont couramment utilisées dans les équations, mais on ne peut pas les saisir
avec le Volet des Éléments ni le menu contextuel. Utilisez les noms dans la langue de l’interface
(français) des lettres grecques dans le langage de balisage pour les faire entrer dans une formule.
Voyez à l’Annexe A Référence des Commandes du guide Math une liste des caractères grecs qui
peuvent être saisi dans le langage de balisage.

• Pour une lettre grecque minuscule, tapez le symbole pourcent % suivi du nom français du
caractère en minuscules. Par exemple, taper %lambda crée la lettre grecque λ.

• Pour une lettre grecque MAJUSCULE, tapez le symbole pourcent % suivi du nom français
du caractère en MAJUSCULES. Par exemple, taper %LAMBDA crée la lettre grecque Λ.

• Pour une lettre grecque en italique, tapez le symbole pourcent % suivi du caractère i puis
du nom français du caractère grec en minuscules ou en MAJUSCULES. Par exemple, ta-
per %iTHÊTA crée la lettre grecque italique Θ.

La boîte de dialogue Symboles
Les lettres grecques peuvent aussi être saisies dans une formule avec la boîte de dialogue Sym-
boles.

 1) Vérifiez que le curseur est dans la position voulue dans l’Éditeur de Formule.
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 2) Allez à Outils > Symboles dans la barre de menu principale ou cliquez sur l’icône Sym-

boles  dans la barre d’outils pour ouvrir la boîte de dialogue Symboles (Figure 5).

 3) Sélectionnez  Grec dans la liste déroulante  Jeu de symboles.  Pour des caractères  ita-
liques, sélectionnez iGrec dans cette même liste déroulante.

 4) Sélectionnez le caractère grec dans la liste des symboles puis cliquez sur Insérer. Quand
un caractère est sélectionné, son nom est indiqué sous la liste des symboles.

 5) Cliquez sur Fermer quand vous avez fini de saisir les lettres grecques dans votre formule.

Figure 5: La boîte de dialogue Symboles

Unicode des caractères grecs
L’inconvénient du balisage  %nom_de_la_lettre_dans_la_langue_de_l’interface est que cela peut
poser problème lorsque le document est ouvert avec une version du logiciel dans une interface de
langue différente. Si cela doit se produire, il est alors conseillé d’utiliser les caractères unicode des
lettres grecques avec une des deux méthodes suivantes :

• insérez la lettre dans Writer, soit par la commande Insérer > Caractères spéciaux, soit par
l’Autocorrection __lettre. Par exemple, __a sera transformé en  α. Copiez-collez la lettre
dans Math

• dans l’éditeur de formule, tapez le code hexadécimal de l’unicode de la lettre, par exemple
3B1 pour α, puis tapez Alt+X

L’avantage de la première méthode est qu’elle ne nécessite pas de connaître l’unicode de la lettre.
L’avantage de la seconde méthode est qu’elle est plus directe.

Exemples de formules

Exemple 1
La formule simple 5×4  peut être créée avec LibreOffice Math comme ceci :

 1) Vérifiez que votre curseur clignote dans l’Éditeur de formule puis sélectionnez la catégorie
Opérateurs unaires/binaires et le symbole de la  Multiplication par l’une des méthodes
suivantes :

– Dans le Volet des Éléments, sélectionnez  Opérateurs unaires/binaires dans la liste

déroulante puis l’icône de la Multiplication .

– Faîtes un clic droit dans l’Éditeur de formule puis sélectionnez Opérateurs Unaires/Bi-
naires > a times b dans le menu contextuel.

 2) Sélectionnez le premier paramètre fictif <?> avant le mot times dans l’Éditeur de formule
et remplacez-le par le chiffre 5. La formule se met automatiquement à jour dans votre do-
cument.
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 3) Sélectionnez le deuxième paramètre fictif  <?> après le mot  times dans l’Éditeur de for-
mule et remplacez-le par le chiffre 4. La formule se met automatiquement à jour dans votre
document.

Les deux premières méthodes placent le texte  <?> times <?> dans l’Éditeur de formule et le

symbole  apparaît dans le document. Ces paramètres fictifs <?> doivent être remplacés par

les vrais nombres. Avec le langage de balisage, saisissez 5 times 4 dans l’Éditeur de formule.
Math place la formule 5×4  directement dans votre document

Conseil
Pour avancer d’un paramètre fictif  <?> au suivant dans une formule, appuyez sur la
touche  F4.  Pour  reculer  d’un paramètre fictif  au précédent,  utilisez la  combinaison
Maj+F4.

NOTE
Si nécessaire, vous pouvez éviter qu’une formule soit mise automatiquement à jour
dans un document. Allez à Affichage dans la barre de menu principale et désélection-
nez  Rafraîchir automatiquement l’affichage. Pour mettre à jour manuellement une
formule, appuyez sur la touche  F9 ou sélectionnez  Affichage > Actualiser dans la
barre de menu principale.

Exemple 2
Vous désirez saisir la formule π ≃ 3,141 59  où la valeur de pi est arrondie à 5 décimales. Vous
connaissez  le  nom  de  la  lettre  grecque  (pi)  mais  pas  la  balise  associée  au  symbole  Est
similaire ou égal ≃ .

 1) Vérifiez que votre curseur clignote dans l’Éditeur de formule.
 2) Saisissez %pi dans l’Éditeur de formule pour entrer la lettre grecque pour pi (π).
 3) Sélectionnez la catégorie Relations et le symbole Est similaire ou égal par l’une des mé-

thodes suivantes ;

– Dans le Volet des Éléments, sélectionnez Relations dans la liste déroulante puis l’icône

Est similaire ou égal .

– Faîtes un clic droit dans l’Éditeur de formule et sélectionnez  Relations > a simeq b
dans le menu contextuel.

 4) Effacez le premier paramètre fictif <?> avant le mot simeq dans l’Éditeur de formule.
 5) Appuyez sur F4 ou sélectionnez le deuxième paramètre fictif <?> après le mot simeq dans

l’Éditeur  de  formule  et  remplacez-le  par  les  caractères  3,141 59.  La  formule
π ≃ 3,141 59  apparaît alors dans votre document.

Éditer des formules

La façon dont on édite une formule et dont on passe en mode d’édition dépend de l’endroit où elle
se trouve, dans Math ou dans un autre module de LibreOffice.

 1) Dans Math, faîtes un double clic sur un élément de la formule qui apparaît dans la Fenêtre
d’Aperçu pour le sélectionner dans l’Éditeur de Formule ou sélectionnez le directement
dans l’Éditeur de formule.

 2) Dans Writer, Calc, Impress ou Draw, faîtes un double clic sur la formule ou un clic droit sur
celle-ci et sélectionner Éditer dans le menu contextuel pour ouvrir l’Éditeur de Formule et
passer en mode d’édition. Le curseur est placé au début de la formule dans l’Éditeur de
Formule.
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NOTE
Si vous ne pouvez pas sélectionner un élément de formule avec votre curseur, cliquez

sur l’icône Curseur de formule  dans la barre d’outils pour activer le curseur de

formule.

 3) Sélectionnez l’élément de formule que vous désirez modifier avec l’une des méthodes sui-
vantes :

– Cliquez sur l’élément de formule dans la Fenêtre d’Aperçu pour positionner le curseur
au début de l’élément de formule puis sélectionnez-le dans l’Éditeur de Formule.

– Faîtes un double clic sur l’élément de formule dans la Fenêtre d’Aperçu pour le sélec-
tionner dans l’Éditeur de Formule.

– Positionnez le curseur dans l’Éditeur de Formule sur l’élément de formule que vous
voulez éditer puis sélectionnez-le.

– Faîtes directement un double clic sur l’élément de formule dans l’Éditeur de Formule
pour le sélectionner.

 4) Effectuez vos modifications sur l’élément de formule que vous avez sélectionné.
 5) Allez à Affichage > Actualiser dans la barre de menu principal, appuyez sur la touche F9

ou cliquez sur l’icône Actualiser  dans la barre d’outils pour mettre à jour si néces-

saire la formule dans la fenêtre de prévisualisation ou votre document.
 6) Dans Math, enregistrez vos modifications de la formule après édition.
 7) Dans Writer, Calc, Impress ou Draw, cliquez n’importe où hors de la formule dans votre do-

cument pour quitter le mode d’édition puis enregistrer votre document pour sauvegarder les
modifications de la formule.

Agencement des formules

Cette section offre quelques conseils sur la façon d’agencer des formules complexes dans Math
ou dans votre document LibreOffice.

Utilisation des accolages
LibreOffice Math ne sait rien de l’ordre des opérations dans une formule. Vous devez utiliser des
accolades pour indiquer l’ordre des opérations à l’intérieur d’une formule. Les exemples suivants
montrent comment utiliser des accolades dans une formule.

Exemple 1

2 over x + 1 donne le résultat 
2
x
+1

Math a reconnu que le 2 avant et le x après le over appartiennent à la fraction et les a re-
présentés en conséquence. Si vous voulez que le dénominateur soit x+1 au lieu de x, vous
devez le placer entre accolades. Mettre des accolades dans 2 over {x + 1} donne le ré-

sultat 
2
x+1

 où x+1 est maintenant au dénominateur.

Exemple 2

– 1 over 2 donne le résultat 
−1
2
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Math a reconnu le signe moins comme préfixe du 1 et l’a donc placé au numérateur de la
fraction. Si vous désirez montrer que la fraction est négative, avec le signe moins devant
elle, vous devez mettre celle-ci entre accolades pour indiquer à Math que ce signe s’applique
à l’ensemble.

Ajouter des accolades dans le langage de balisage – {1 over 2} donne le résultat –
1
2

et la fraction est maintenant négative.

Exemple 3

Quand les  accolades  sont  utilisées  dans le  langage de balisage,  elles  servent  à  définir
l’agencement de la formule et ne sont ni affichées ni imprimées. Si vous voulez faire appa-
raître des accolages à l’intérieur d’une formule, utilisez les commandes lbrace et rbrace
dans le langage de balisage.

x over {–x + 1} donne le résultat 
x

– x+1

Remplacez les accolades en utilisant les commandes lbrace et  rbrace dans le langage

de balisage. Écrivez x over lbrace –x + 1 rbrace et le résultat est 
x

{– x+1}

Parenthèses et matrices
Si vous voulez utiliser une matrice dans une formule, vous devez utiliser la commande matrix.

Par exemple,  matrix { a # b ## c # d } donne comme résultat la matrice  
a b
c d

 dans

votre formule. Les lignes sont séparées par deux dièses (##) et les entrées dans chaque ligne par
un seul dièse (#).

Normalement, quand vous utilisez des parenthèses dans une matrice, celles-ci ne s’adaptent pas
quand la taille de la matrice augmente. Par exemple,  ( matrix { a # b ## c # d } )

donne le résultat (a b
c d

) .

Pour résoudre ce problème de parenthésage d’une matrice, LibreOffice Math propose des paren-
thèses variables  dont  la  taille  augmente  avec celle  de la  matrice.  Les  commandes  left( et
right) doivent  être  utilisées  pour  créer  des  parenthèses  ajustables  dans  une  matrice.  Par

exemple, left( matrix { a # b ## c # d } right) donne le résultat (a b
c d)  où la ma-

trice est maintenant entourée de parenthèses variables.

Les parenthèses variables peuvent aussi être utilisées avec n’importe quel élément de formule,
comme les fractions, les racines carrées et ainsi de suite.

Conseil
Utilisez les commandes  left[ et  right] pour obtenir des crochets de taille adap-
table. Une liste de toutes les parenthèses disponibles dans Math est située dans l’An-
nexe A, Référence des Commandes du Guide de Math.
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Conseil
Si vous désirez que toutes les parenthèses aient un taille variable, allez à  Format >
Espacement pour ouvrir la boîte de dialogue Espacement. Cliquez sur Catégorie, sé-
lectionnez Accolades dans la liste déroulante puis l’option  Ajuster toutes les paren-
thèses.

Parenthèses non appariées
Quand on utilise des parenthèses dans une formule, Math attend que, pour chaque parenthèse ou-
vrante, il en existe une fermante. Si vous oubliez d’ajouter une parenthèse fermante, Math place
un point d’interrogation à l’envers près de l’endroit où celle-ci devrait se trouver. Celui-ci disparaît
quand toutes les parenthèses sont appariées. Une parenthèse non appariée est cependant parfois
nécessaire et vous avez les options suivantes.

Parenthèses de taille fixe
Une barre oblique inversée \ est placée avant une parenthèse de taille fixe pour indiquer que le ca-
ractère qui la suit ne doit pas être considéré comme une parenthèse mais comme un caractère or-
dinaire.

Par exemple, les crochets sont délibérément non appariés dans la formule [ a; b [, mais donne

le résultat  
¿

a ;b ¿
¿

. Pour supprimer les points d’interrogation renversés et créer des crochets non

appariés, des barres obliques inversées sont ajoutées. La formule devient alors \ [ a; b \ [ et
le résultat [a;b [  affiche des crochets non appariés sans les points d’interrogation renversés.

Parenthèses de taille variable
Pour créer des parenthèses ou des accolades de taille variable non appariées, on utilise les com-
mandes de balisage left, right et none.

Exemple

Vous voulez  créer  la  formule  |x|={ x pour x≥0
−x pour x<0

 et  vous saisissez  abs x = lbrace

stack {x "pour" x >= 0 # -x "pour" x < 0} dans l’Éditeur de Formule.

Mais vous obtenez ce résultat incorrect 
x pour x≥0

−x pour x<0
|x|=¿

 .

Pour faire disparaître le point d’interrogation renversé et créer une formule correcte, vous de-
vez utiliser les commandes de balisage  left,  right et  none. Modifiez votre saisie dans
l’Éditeur d’équation pour  abs x = left lbrace stack {x "pour" x >= 0 # -x
"pour" x < 0} right none et cela vous donne la formule correcte.

Reconnaissance des fonctions
Dans l’installation par défaut de Math, celui-ci produit des fonctions en caractères normaux et des
variables en italique. Mais si Math n’arrive pas à reconnaître une fonction, vous pouvez lui dire que
vous venez d’en saisir une. Saisir la commande de balisage func avant une fonction oblige Math
à reconnaître le texte suivant comme une fonction et à utiliser des caractères normaux.

Pour une liste complète des fonctions dans Math, voyez l’Annexe A Référence des Commandes
du Guide de Math.

Certaines fonctions de Math doivent être suivies d’un nombre ou d’une variable. Si ceux-ci sont ab-
sents, Math place un point d’interrogation renversé où ils devraient se trouver. Pour le faire dispa-
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raître et corriger la formule, vous devez saisir un nombre, une variable ou une paire d’accolades
vide {} comme paramètre fictif.

Conseil
Vous pouvez passer d’une erreur à l’autre dans une formule grâce à la touche F3 et à
la combinaison de touches Maj+F3.

Formules sur plusieurs lignes

Supposons que vous vouliez créer une formule qui demande plusieurs lignes, par exemple x=3
y=1

.

Votre première réaction serait normalement d’appuyer sur la touche  Entrée. Si vous le faîtes, le
langage de balisage passe bien à la ligne dans l’Éditeur de Formule mais la formule produite n’a
pas deux lignes. Vous devez taper la macro-commande newline à chaque fois que vous voulez
créer et afficher une nouvelle ligne dans une formule.

Exemple
x = 3
y = 1
donne le résultat incorrect x=3 y=1

x = 3 newline y = 1 donne le résultat correct x=3
y=1

On ne peut pas créer dans Math de formules de plusieurs lignes quand l’une d’elles se termine par
un signe égal et que l’on veut continuer le calcul sur une nouvelle ligne sans indiquer le membre
de droite du signe égal. Si vous devez le faire, utilisez soit des guillemets vides "", soit des acco-
lades vides {}, soit les caractères d’espacement accent grave ` ou tilde ~.

Par défaut, les formules sur plusieurs lignes sont centrées. Pour plus d’information sur l’alignement
sur le signe égal, voir ci-dessous « Aligner les formules sur le signe égal » page 19.

L’espace entre les éléments d’une formule n’est pas défini par l’utilisation de caractères espace
dans le langage de balisage. Si vous voulez ajouter des espaces dans votre formule, utilisez une
des options suivantes :

• un accent grave ` pour ajouter un petit espace.
• un tilde ~ pour un grand espace.
• ajouter des caractères espace entre guillemets " ". Ils seront considérés comme du texte.

Tout espace à la fin d’une ligne de langage de balisage est ignoré par défaut. Pour plus d’informa-
tion, voir le Guide de Math.

Ajout de limites aux commandes somme et intégrale
Les commandes sum et int permettent de créer des formules avec des sommes et des intégrales
respectivement. Elles peuvent recevoir les paramètres from et to si vous voulez définir les limites
respectivement inférieure et supérieure. Ils peuvent être utilisés seuls ou ensemble comme on le
voit sur les exemples suivants. Pour plus d’informations sur les commandes somme et intégrale,
voyez le Guide de Math.

Exemples

sum from k = 1 to n a_k donne le résultat ∑
k=1

n

ak

int from 0 to x f(t) dt donne le résultat ∫
0

x

f (t)dt
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int_0^x f(t) dt donne le résultat ∫0

x

f (t)dt

int from Re f donne le résultat ∫
ℜ

f

sum to infinity 2^{-n} donne le résultat ∑
∞

2−n

Écriture des dérivées
Pour écrire une dérivée, vous devez indiquer à Math que c’est une fraction en utilisant la com-
mande over. Celle-ci est combinée avec le caractère d pour une dérivée totale ou la commande
partial pour une dérivée partielle pour obtenir l’effet désiré. Des accolades {} entourent l’élé-
ment et font apparaître les dérivées comme on le voit dans les exemples suivants.

Exemples

{df} over {dx} donne le résultat 
df
dx

{partial f} over {partial y} donne le résultat 
∂ f
∂ y

{partial^2 f} over {partial t^2} donne le résultat 
∂2 f

∂ t2

Remarque
Pour écrire les noms de fonctions avec un prime, comme dans la notation scolaire ha-
bituelle, vous devez d’abord ajouter le symbole au catalogue. Voyez le Guide de Math
pour plus d’informations.

Caractères du langage de balisage employés comme caractères 
ordinaires
Les caractères utilisés comme caractères de contrôle dans le langage de balisage ne peuvent pas
être saisis directement comme des caractères normaux. Ce sont les caractères %, {, }, &, |, _, ^
et ". Par exemple, vous ne pouvez pas écrire 2% = 0,02 dans le langage de balise et vous at-
tendre à voir apparaître les mêmes caractères dans votre formule. Pour surmonter cette limitation
du langage, utilisez une des méthodes suivantes :

• Utilisez des guillemets doubles de chaque côté du caractère pour le marquer comme texte.
Par exemple,  2"%"= 0,02 apparaîtra comme 2%=0,02  dans votre formule. Cette mé-
thode n’est cependant pas applicable au caractère guillemet double lui-même, voyez « Du
texte dans les formules » ci-dessous.

• Ajoutez le caractère au catalogue de Math, par exemple le caractère guillemet double.
• Utilisez des commandes, par exemple lbrace et rbrace vous donne des caractères ac-

colades {} .

Remarque
Le dialogue Caractères spéciaux utilisé par les autres modules de LibreOffice n’est pas
disponible dans Math. Si vous avez régulièrement besoin de caractères spéciaux dans
Math, il est recommandé de les ajouter au Catalogue. Voyez le  Guide de Math pour
plus d’informations.
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Du texte dans les formules
Pour inclure du texte dans une formule, vous devez l’entourer de guillemets doubles, par exemple
x " pour " x >= 0 dans le langage de balisage va créer la formule x  pour x≥0 . Tous les ca-
ractères, sauf les guillemets doubles, peuvent être utilisés dans le texte. Si, cependant, vous avez
besoin de guillemets doubles dans le texte d’une formule, vous pouvez utiliser le caractère unicode
ʺ ou ˮ en tapant 2BA ou 2EE puit Alt+X. Une autre solution consiste à créer un caractère spécial
(voir Guide de Math).

La police utilisée pour le texte dans une formule est la police par défaut définie dans la boîte de
dialogue Polices. Pour plus d’informations sur la façon de modifier les polices utilisées dans les
formules, voyez « Modifier l’apparence d’une formule » page 20.

Par défaut, l’alignement du texte est à gauche dans les formules. Pour plus d’information sur la fa-
çon de modifier l’alignement du texte, voyez « Ajuster l’alignement des formules » page 23.

Les commandes de mise en forme ne sont pas interprétées à l’intérieur du texte utilisé dans les
formules. Si vous voulez le faire, vous devez séparer le texte par des guillemets doubles dans
l’Éditeur de Formule.
Exemple

Saisissez le texte suivant dans l’Éditeur de formule :

"Dans un triangle " color blue bold "isocèle" "les angles à la base
sont égaux"

vous obtenez le texte suivant dans une formule :
Dans un triangle isocèle les angles à la base sont égaux  

Aligner les formules sur le signe égal
LibreOffice Math ne possède pas de commande pour aligner les formules sur un caractère particu-
lier. Cependant, vous pouvez utiliser une matrice pour aligner les formules sur un caractère qui est
normalement le signe égal (=).

Exemple
Créer la matrice :

matrix{ alignr x+y # {}={} # alignl 2 ## alignr x   # {}={} # alignl
2-y }

donne le résultat suivant où les formules sont alignées sur le signe égal x+ y = 2
x = 2− y

Remarque
Les accolades vides de chaque côté des signes égal sont nécessaires parce que celui-
ci est un opérateur binaire qui exige une expression de part et d’autre. Vous pouvez
utiliser des caractères espace,  ` ou ~ mais les accolades sont recommandées, car
elles sont plus visibles dans le langage de balisage.

Vous pouvez réduire l’espacement de chaque côté des signes égal en modifiant l’espace entre les
colonnes de la matrice. Voyez « Ajuster l’espacement dans les formules » page 22 pour plus d’in-
formation sur la façon de le faire.
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Modifier l’apparence d’une formule

Taille de la police d’une formule

Taille de la police de la formule en cours
Pour modifier la taille de la police utilisée dans une formule déjà insérée dans Math ou un autre
module de LibreOffice :

 1) Cliquez dans le langage de balisage dans l’Éditeur de Formule.
 2) Allez à Format > Taille de police dans la barre de menu principale pour ouvrir la boîte de

dialogue Tailles de police (Figure 6).
 3) Choisissez une taille de police avec le sélecteur  Taille de base ou tapez-la directement

dans la boîte.
 4) Cliquez sur OK pour enregistrer vos modifications et refermer la boîte de dialogue. Voyez

ci-dessous un exemple obtenu en modifiant la taille de la police.

Exemple
Taille de police par défaut : π ≃ 3,14159

Après changement de taille de police à 18 pt : π ≃ 3,14159

Figure 6 : La boîte de dialogue Tailles de police

Taille par défaut de la police dans les formules
Pour modifier la taille par défaut de la police utilisée par toutes les formules dans Math ou un autre
module de LibreOffice :

 1) Avant d’insérer une formule dans votre document, allez à Format > Taille de police dans
la barre de menu principale pour ouvrir la boîte de dialogue Tailles de police (Figure 6).

 2) Sélectionnez une taille de police différente avec le sélecteur  Taille de base ou tapez une
nouvelle taille dans la zone de saisie.

 3) Cliquez sur Par défaut et confirmez vos changements de la taille de base de la police.
Toute formule créée à partir de ce moment-là utilisera la nouvelle taille de base.

 4) Cliquez sur OK pour enregistrer vos modifications et refermer la boîte de dialogue.

Remarque
Si vous avez déjà inséré des formules dans votre document et que vous modifiez la
taille de police par défaut, seules les formules insérées après la modification utiliseront
le nouveau réglage. Vous devez modifier individuellement la taille de la police des for-
mules déjà insérées si vous voulez que celles-ci utilisent la taille par défaut que vous
venez de configurer.
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Polices des formules

Polices de la formule en cours
Pour modifier  les polices utilisées par la  formule en cours dans Math ou un autre module de
LibreOffice :

 1) Cliquez dans le langage de balisage dans l’Éditeur de Formule.
 2) Allez à Format > Polices dans la barre de menu principale pour ouvrir la boîte de dialogue

Polices (Figure 7).
 3) Sélectionnez une nouvelle police pour chaque option dans les listes déroulantes.
 4) Si la police que vous désirez utiliser n’apparaît pas dans la liste déroulante, cliquez sur Mo-

difier et sélectionnez l’option dans le menu contextuel pour ouvrir la boîte de dialogue de
polices. Choisissez-y la police que vous voulez utiliser et cliquez sur OK pour l’ajouter à la
liste déroulante de cette option.

 5) Cliquez sur OK pour enregistrer vos modifications et fermer la boîte de dialogue Polices.

Figure 7 : La boîte de dialogue Polices

Polices par défaut des formules
Pour changer les polices par défaut utilisées par toutes les nouvelles formules dans Math et les
autres modules de LibreOffice :

 1) Avant d’insérer une formule dans votre document, allez à Format > Polices dans la barre
de menu principale pour ouvrir la boîte de dialogue Polices (Figure 7).

 2) Sélectionnez une nouvelle police pour chaque option dans les listes déroulantes.
 3) Si la police que vous désirez utiliser n’apparaît pas dans la liste déroulante, cliquez sur Mo-

difier et sélectionnez l’option dans le menu contextuel pour ouvrir la boîte de dialogue de
polices. Choisissez-y la police que vous voulez utiliser et cliquez sur OK pour l’ajouter à la
liste déroulante de cette option.

 4) Cliquez sur  Par défaut et  confirmez vos modifications des polices. Toutes les formules
créées à partir de ce point utiliseront les nouvelles polices.

 5) Cliquez sur OK pour enregistrer vos modifications et fermer la boîte de dialogue Polices.
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Remarque
Si vous avez déjà inséré des formules dans votre document et que vous modifiez les
polices par défaut, seules les formules insérées après la modification utiliseront le nou-
veau réglage. Vous devez modifier individuellement les polices des formules déjà insé-
rées si vous voulez que celles-ci utilisent les polices par défaut que vous venez de
configurer. Si le nombre de formules est important, une macro permettant d’automati-
ser la modification est proposée dans le Guide de Math.

Ajuster l’espacement dans les formules
Utilisez la boîte de dialogue Espacement (Figure 8) pour déterminer l’espacement entre les élé-
ments d’une formule. L’espacement est donné en pourcentage de la taille de base définie pour les
polices.

Espacement de la formule en cours
 1) Cliquez dans l’Éditeur de Formule.
 2) Allez à Format > Espacement dans la barre de menu pour ouvrir la boîte de dialogue d’es-

pacement (Figure 8).
 3) Cliquez sur  Catégorie et choisissez une des options dans la liste déroulante. Les choix

dans la boîte de dialogue d’Espacement change en fonction de la catégorie sélectionnée.
 4) Saisissez les nouvelles valeurs d’espacement pour cette catégorie et cliquez sur OK.
 5) Vérifiez  le  résultat  dans votre formule.  S’il  ne vous donne pas satisfaction,  répéter  les

étapes précédentes.

Figure 8 : La boîte de dialogue d'Espacement

Espacement par défaut des formules
Pour modifier l’espacement par défaut utilisé par toutes les nouvelles formules dans Math et les
autres modules de LibreOffice :

 1) Avant d’insérer une formule dans un document, allez à Format > Espacement sur la barre
de menu pour ouvrir la boîte de dialogue Espacement (Figure 8).

 2) Cliquez sur  Catégorie et choisissez une des options dans la liste déroulante. Les choix
dans la boîte de dialogue d’Espacement change en fonction de la catégorie sélectionnée.

 3) Saisissez les nouvelles valeurs d’espacement pour cette catégorie. Cliquez sur Par défaut
pour confirmer les modifications des espacements dans les formules. Toute formule créée
à partir de ce moment utilisera les nouveaux espacements.

 4) Cliquez sur OK pour enregistrer vos changements et fermer la boîte de dialogue d’Espace-
ment.
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Remarque
Si vous avez déjà inséré des formules dans votre document et que vous modifiez les
espacements par défaut, seules les formules insérées après la modification utiliseront
le nouveau réglage. Vous devez modifier individuellement les espacements des for-
mules déjà insérées si vous voulez que celles-ci utilisent les espacements par défaut
que vous venez de configurer.

Ajuster l’alignement des formules
Les paramètres d’alignement déterminent la façon dont les éléments de formules situés les uns en
dessous des autres sont alignés horizontalement les uns par rapport aux autres.

Remarque
Il n’est pas possible d’aligner les formules sur un caractère particulier et l’alignement
des formules (avec la méthode décrite ci-dessous) ne s’applique pas aux éléments tex-
tuels qui sont toujours alignés à gauche.
Indépendamment de l’alignement proposé ci-dessous, il est possible d’aligner les for-
mules grâce aux commandes alignl, alignc et alignr qui conviennent aussi pour
les éléments textuels.

Alignement de la formule en cours
Pour  modifier  l’alignement  utilisé  par  la  formule  en  cours  dans Math  ou  un autre  module  de
LibreOffice :

 1) Cliquer sur le langage de balisage dans l’Éditeur de Formule.
 2) Allez à Format > Alignement dans la barre de menu pour ouvrir la boîte de dialogue Ali-

gnement (Figure 9).
 3) Choisissez Gauche, Centré ou Droite comme alignement horizontal.
 4) Cliquez sur OK et contrôler le résultat dans votre formule. S’il ne vous donne pas satisfac-

tion, reprenez les étapes précédentes.

Figure 9 : La boîte de dialogue Alignement

Alignement par défaut des formules
Pour modifier l’alignement utilisé par défaut par toutes les nouvelles formules dans Math et les
autres modules de LibreOffice :

 1) Avant d’insérer une formule dans un document, allez à Format > Alignement sur la barre
de menu pour ouvrir la boîte de dialogue Alignement (Figure 9).

 2) Sélectionnez Gauche, Centré ou Droite comme alignement horizontal.
 3) Cliquez sur Par défaut pour confirmer les modifications de l’alignement dans les formules.

Toute formule créée à partir de ce moment utilisera le nouvel alignement.
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 4) Cliquez sur OK pour enregistrer vos changements et fermer la boîte de dialogue d’Aligne-
ment.

Remarque
Si vous avez déjà inséré des formules dans votre document et que vous modifiez les
alignements par défaut, seules les formules insérées après la modification utiliseront le
nouveau réglage. Vous devez modifier individuellement les alignements des formules
déjà insérées si vous voulez que celles-ci utilisent les alignements par défaut que vous
venez de configurer.

Modifier la couleur dans une formule

La couleur des caractères
Pour modifier la couleur des caractères utilisés dans une formule, servez-vous de la commande
color dans le langage de balisage. Celle-ci ne s’applique qu’à l’élément de formule qui suit immé-
diatement le nom de la couleur. Par exemple, saisir  color red ABC 5 times 4 dans le lan-
gage de balisage donne le résultat ABC 5×4 .

Pour modifier la couleur de l’ensemble de la formule, vous devez l’encadrer par des accolades.
Par  exemple,  le  langage  de  balisage  color red {ABC 5 times 4} donne  le  résultat
ABC 5×4 .

Pour plus d’informations sur les couleurs disponibles dans Math, voyez le Guide de Math.

Conseil
Pour vous faciliter la tâche, le Volet des Éléments comporte la catégorie Attributs qui
propose la liste des couleurs standards. Cliquez sur la couleur désirée pour insérer la
commande dans votre formule.

La couleur d’arrière-plan
Il n’est pas possible de choisir une couleur de fond pour les formules dans LibreOffice Math. Par
défaut, l’arrière-plan d’une formule a la couleur du document ou du cadre où la formule a été insé-
rée. Dans les documents de LibreOffice, vous pouvez cependant utiliser les propriétés des objets
pour modifier la couleur de fond d’une formule. Pour plus d’informations sur l’utilisation d’une cou-
leur  d’arrière-plan  (remplissage  pour  les  objets)  avec  une  formule,  veuillez  vous  reporter  aux
guides de l’Utilisateur de Writer, Calc, Draw et Impress.

Bibliothèque de formules

Si vous insérez régulièrement les mêmes formules dans vos documents, vous pouvez créer une
bibliothèque formules avec celles que vous avez créées dans l’Éditeur de Formule. Les formules
peuvent être sauvegardées individuellement dans des fichiers au format ODF avec l’extension .odf
ou au format MathML avec l’extension .mml.

Vous pouvez utiliser les modules Math, Writer, Calc, Draw ou Impress de LibreOffice pour créer
vos formules et bâtir votre bibliothèque.

Avec Math
 1) Créer un dossier sur votre ordinateur pour y ranger vos formules. Donnez-lui un nom facile

à retenir, par exemple Bibliothèque de Formules.
 2) Dans LibreOffice, allez à Fichier > Nouveau > Formule dans la barre de menu ou cliquez

sur Formule Math dans l’écran d’accueil pour ouvrir LibreOffice Math et créer votre formule
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avec l’Éditeur de Formule. Voyez « Les formules en tant que documents indépendants »
page 8 pour plus d’informations.

 3) Allez à Fichier > Enregistrer sous dans la barre de menu ou utilisez les touches de rac-
courcis Ctrl+Maj+S pour ouvrir la boîte de dialogue Enregistrer sous.

 4) Recherchez le dossier que vous avez créé pour votre bibliothèque de formules.
 5) Tapez un nom facile à retenir pour votre formule dans la zone de texte Nom de fichier.
 6) Dans la liste déroulante Type de fichier, choisissez soit  Formule ODF (.odf) soit  MathML

1.01 (.mml) comme type de fichier pour votre formule.
 7) Cliquez sur Enregistrer pour enregistrer la formule et fermer la boîte de dialogue Enregis-

trer sous.

Avec Writer, Calc, Draw ou Impress
 1) Créer un dossier sur votre ordinateur pour y ranger vos formules. Donnez-lui un nom facile

à retenir, par exemple Bibliothèque de Formules.
 2) Ouvrez un document avec Writer, Calc, Draw ou Impress.
 3) Allez à Insertion > Objet > Formule dans la barre de menu pour ouvrir l’Éditeur de For-

mule et créer la vôtre. Voyez « Les formules dans les documents de LibreOffice » page 7
pour plus d’informations.

 4) Faites un clic droit sur l’objet formule et cliquez sur  Enregistrer la copie sous dans le
menu contextuel pour ouvrir la boîte de dialogue Enregistrer sous.

 5) Recherchez le dossier que vous avez créé pour votre bibliothèque de formules.
 6) Tapez un nom facile à retenir pour votre formule dans la zone de texte Nom de fichier.
 7) Dans la liste déroulante Type de fichier, choisissez soit  Formule ODF (.odf) soit  MathML

1.01 (.mml) comme type de fichier pour votre formule.
 8) Cliquez sur Enregistrer pour enregistrer la formule et fermer la boîte de dialogue Enregis-

trer sous.

Utiliser votre bibliothèque de formules
Il n’est pas possible d’insérer une formule de votre bibliothèque dans un document par glissé/dé-
posé avec la souris ni en utilisant Insertion > Fichier dans la barre de menu. Il faut l’insérer dans
votre document sous forme d’objet OLE.

 1) Ouvrez le document dans Writer, Calc, Draw ou Impress.
 2) Allez à Insertion > Objet > Objet OLE dans la barre de menu pour ouvrir la boîte de dia-

logue Insérer un objet OLE.
 3) Cochez l’option Créer à partir d’un fichier.
 4) Cliquez sur Rechercher pour ouvrir la boîte de dialogue de recherche de fichiers.
 5) Recherchez le dossier que vous avez créé pour votre bibliothèque de formules.
 6) Sélectionnez la formule que vous désirez insérer et cliquez sur Ouvrir ou faites un double

clic sur la formule.
 7) Cliquez sur OK pour insérer la formule dans le document sous forme d’objet OLE et fermer

la boîte de dialogue Objet OLE.

Conseil
Dans Writer, une autre méthode efficace pour insérer une formule régulièrement utili-
sée, est de passer par un AutoTexte. Reportez-vous à la section sur l’AutoTexte au
chapitre 4 du Guide de Démarrage de Writer.

Les formules dans Writer

Quand une formule est  insérée dans un document,  Writer  la  place dans un cadre et  la  traite
comme un objet OLE. Un double clic sur une formule insérée ouvre l’Éditeur de Formule dans
Math où vous pouvez la modifier.
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Cette partie explique quelles options peuvent être modifiées pour chaque formule à l’intérieur d’un
document Writer. Veuillez vous reporter aux chapitres sur les styles du Guide de Writer pour toute
information sur la manière de modifier les paramètres par défaut des styles de cadre des objets
OLE.

Numérotation automatique des formules
La numérotation automatique des formules pour effectuer des renvois ne peut s’effectuer que dans
LibreOffice Writer.

Numérotation
 1) Débuter une nouvelle ligne dans votre document
 2) Tapez nf (pensez à numéro de formule) puis appuyez sur la touche F3. Un tableau à deux

colonnes, sans bordures, est inséré dans le document avec une formule d’exemple dans la
colonne de gauche et un numéro de renvoi dans celle de droite comme ci-dessous.

E=mc2 (1)

 3) Effacez  la  formule  d’exemple  et  insérez  la  vôtre  en  tant  qu’objet  dans  la  colonne  de
gauche. Voyez « Créer des formules » page 9 pour plus d’informations sur l’insertion des
formules.

Vous pouvez aussi  commencer par insérer  votre formule dans le  document  puis  effectuer  les
étapes 1 et 2 ci-dessus et remplacer la formule d’exemple par la vôtre.

Remarque
Si vous désirez utiliser des crochets à la place des parenthèses autour du numéro de
la formule ou si vous voulez que le numéro de formule soit séparé de celle-ci par une
tabulation plutôt que placées dans un tableau, vous devrez modifier l’entrée d’Auto-
Texte pour  nf. Reportez-vous à la section sur l’AutoTexte au chapitre 4 du  Guide de
Démarrage de Writer.

Renvoi
 1) Cliquez dans le document où vous voulez faire apparaître le renvoi.
 2) Allez à Insertion > Renvoi dans la barre de menu pour ouvrir la boîte de dialogue Champs

(Figure 10).
 3) Cliquez sur l’onglet Renvoi puis sélectionnez Texte dans la section Type.
 4) Dans la partie Sélection, choisissez le numéro de formule auquel vous voulez renvoyer.
 5) Dans la partie Insérer une référence à, choisissez Référence et cliquez sur Insérer.
 6) Quand vous avez fini de créer des renvois, cliquez sur Fermer pour refermer la boîte de

dialogue Champs.

Conseil
Pour insérer le numéro de référence sans parenthèses, choisissez Numérotation à la
place de Référence dans la zone Insérer une référence à.
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Figure 10 : La boîte de dialogue Champs à la page Renvoi

Ancrage des formules
Dans Writer, une formule est traitée comme un objet dont l’ancrage par défaut est Comme carac-
tère dans le paragraphe où elle est insérée dans un document. Pour modifier l’ancrage d’un objet
formule :

 1) Faites un clic droit sur l’objet formule choisi et sélectionnez Ancrer dans le menu contex-
tuel.

 2) Choisissez une nouvelle option d’ancrage dans le sous-menu. Les possibilités sont  À la
page, Au paragraphe, Au caractère ou Comme caractère.

Vous pouvez aussi,

 1) Faire un clic droit sur l’objet formule et sélectionner Objet dans le menu contextuel ou aller
à Format > Cadre et objet > Propriétés dans la barre de menu pour ouvrir la boîte de dia-
logue Objet (Figure 11).

 2) Sélectionner l’onglet Type et choisir une nouvelle position d’ancrage dans la zone Ancrer.
 3) Cliquer sur OK pour enregistrer les modifications et fermer la boîte de dialogue Objet.

Remarque
Les options d’ancrage ne sont pas disponibles dans la boîte de dialogue Objet quand
vous effectuez des modifications des diverses options disponibles pour les styles de
cadre. Pour plus d’informations sur la façon de modifier les styles de cadres, veuillez
vous reporter aux chapitres sur les styles dans le Guide de Writer.
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Figure 11 : La boîte de dialogue Objet - Page Type avec les options d'ancrage

Alignement vertical
L’alignement vertical par défaut pour les objets formules utilise la ligne de base du texte comme ré-
férence. Ce paramétrage par défaut peut être changé en modifiant le style de cadre des formules.
Voyez les chapitres sur les styles dans le Guide de Writer pour plus d’informations.

Pour modifier l’alignement vertical d’un objet formule unique :

 1) Faites un clic droit sur la formule et sélectionnez Objet dans le menu contextuel ou allez à
Format > Cadre et objet > Propriétés pour ouvrir la boîte de dialogue Objet (Figure 11).

 2) Sélectionnez l’onglet Type et choisissez un nouvel alignement dans la liste déroulante Ver-
tical de la section Position. Les options possibles sont Haut, Bas, Centre et Du bas.

 3) Si nécessaire, saisissez dans la zone de texte un décalage positif ou négatif d’alignement
vertical. Cette possibilité n’est offerte que si l’alignement Du bas a été choisi.

 4) Choisissez le type d’alignement par rapport au texte dans la liste déroulante de la section
Position. Les choix disponibles sont Ligne de base, Caractère et Ligne.

 5) Cliquez sur OK pour enregistrer vos modifications et fermer la boîte de dialogue Objet.

Remarque
Si la section Position de la boîte de dialogue Objet est grisé et inaccessible, allez à Ou-
tils > Options > LibreOffice Writer > Aide au formatage et décochez l’option Aligne-
ment de la ligne de base Math. Ce paramètre est stocké avec le document et s’ap-
plique à toutes les formules qu’il contient. Tout nouveau document utilisera aussi ce pa-
ramétrage.
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Espacement des objets
Un objet formule, une fois inséré dans un document Writer, possède un espacement de chaque
côté. La valeur par défaut utilisée pour celui-ci est définie dans le style de cadre des formules et
peut être modifiée en changeant ce style, voyez les chapitres sur les styles dans le  Guide de
Writer pour plus d’informations.

Vous pouvez ajuster séparément l’espacement de chaque objet formule à l’intérieur d’un document
de la manière suivante :

 1) Créez la formule dans votre document Writer.
 2) Faites un clic droit sur l’objet formule et sélectionnez Objet dans le menu contextuel ou al-

lez à Format > Cadre et objet > Propriétés pour ouvrir la boîte de dialogue Objet.

Figure 12 : La boîte de dialogue Objet - Onglet Adapter

 3) Cliquez sur l’onglet Adapter (Figure 12).
 4) Dans la section  Espacement,  saisissez les valeurs d’espacement pour  Gauche,  Droite,

Haut et Bas.
 5) Cliquez sur OK pour enregistrer vos modifications et fermer la boîte de dialogue Objet.

Le mode texte
Quand une grande formule est placée dans une ligne de texte, ses éléments peuvent souvent dé-
passer la hauteur du texte. Pour qu’elles soient plus faciles à lire, il est donc recommandé de tou-
jours insérer les formules dans un paragraphe indépendant.

Cependant, s’il s’avère nécessaire de placer une grande formule dans une ligne de texte, faites un
double clic sur celle-ci pour ouvrir l’Éditeur de Formule puis sélectionnez Format > Mode Texte
dans la barre de menu. L’Éditeur de Formule va alors essayer de la compresser pour la faire tenir
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dans la hauteur du texte. Les numérateurs et dénominateurs des fractions sont réduits et les li -
mites des intégrales et des sommes sont placées à côté du signe intégral ou somme comme le
montre l’exemple suivant.

Exemple
Une formule dans un paragraphe séparé :

∑
i=2

5

i2

et la même formule incorporée dans une ligne de texte grâce au mode texte : ∑i=2
5 i2

Arrière-plan et bordures
Le paramétrage par défaut de l’arrière-plan (zone) et des bordures pour les objets formules est dé-
fini dans le style de cadre des formules et peut être modifié en changeant ce style, voyez les cha-
pitres sur les styles dans le Guide de Writer pour plus d’informations. Vous pouvez cependant mo-
difier individuellement l’arrière-plan et les bordures des formules.

Remarque
La taille du cadre dans lequel une formule est placée quand elle est insérée dans un
document ne peut pas être modifiée. Elle dépend du paramétrage de la taille de police
de la formule ; voyez le Guide de Math pour plus d’informations.

Arrière-plans
 1) Sélectionnez dans le document la formule dont vous désirez modifier l’arrière-plan.
 2) Faites un clic droit sur l’objet formule et sélectionnez Objet dans le menu contextuel ou al-

lez à Format > Cadre et objet > Propriétés pour ouvrir la boîte de dialogue Objet.
 3) Cliquez sur l’onglet  Zone et choisissez le type de remplissage que vous désirez utiliser

pour la formule dans la liste déroulante Remplir (Figure 13) ;

Figure 13 : La boîte de dialogue Objet - Onglet Zone

 4) Sélectionnez les options que vous voulez appliquer au fond de la formule. Celles-ci dé-
pendent du type de remplissage choisi.

 5) Cliquez sur OK pour enregistrer vos modifications et fermer la boîte de dialogue Objet.
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Bordures
 1) Sélectionnez dans le document la formule dont vous désirez modifier l’arrière-plan.
 2) Faites un clic droit sur l’objet formule et sélectionnez Objet dans le menu contextuel ou al-

lez à Format > Cadre et objet > Propriétés pour ouvrir la boîte de dialogue Objet.
 3) Cliquez sur l’onglet Bordures et sélectionnez les options que vous désirez appliquer aux

bordures de la formule (Figure 14).
 4) Cliquez sur OK pour enregistrer vos modifications et fermer la boîte de dialogue Objet.

Figure 14 : La boîte de dialogue Objet - Onglet Bordures

Insertion rapide de formules
Pour insérer rapidement une formule dans un document Writer sans ouvrir l’Éditeur de Formule
quand vous connaissez le langage de balisage de cette formule :

 1) Saisissez le langage de balisage de la formule dans le document à l’endroit où vous voulez
voir apparaître la formule.

 2) Sélectionnez le langage de balisage.
 3) Allez à Insertion > Objet dans la barre de menu et sélectionnez Formule ou cliquez sur

l’icône Formule  dans la barre d’outils Standard pour créer une formule à partir de la

sélection.

Remarque
Si l’icône Formule n’est pas visible dans la barre d’outils Standard, faites un clic droit
dans une zone vide de la barre d’outils, choisissez  Boutons visibles dans le menu
contextuel puis Formule parmi les boutons disponibles.

Les formules dans Calc, Draw et Impress

Dans Calc, Draw et Impress, les formules sont insérées sous forme d’objets OLE sans arrière-plan
ni bordures. Voyez le Guide de Math pour plus d’informations.
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Chaque objet formule est inséré dans un classeur, un dessin ou une diapositive de la façon sui-
vante :

• Dans Calc, les formules sont insérées dans une cellule sélectionnée d’un classeur sans
qu’un style lui soit affecté.

• Dans Draw et Impress, les formules sont insérées en position centrale dans un dessin ou
une diapositive et elles reçoivent par défaut le style Objet sans remplissage et sans ligne.
Pour plus d’information sur la façon de modifier ou d’affecter des styles aux objets dessi-
nés, voyez le Guide de Draw ou le Guide d’Impress.

Ancrage des formules

Dans Calc
Un objet formule peut être ancré dans un classeur À la page (paramétrage par défaut) ou À la cel-
lule. Pour modifier le type d’ancrage d’une formule dans un classeur :

 1) Sélectionnez l’objet formule dans le classeur.
 2) Faites un clic droit sur la formule et choisissez Ancrage > À la page ou À la cellule dans

le menu contextuel.
 3) Vous pouvez aussi aller à Format > Ancrer dans la barre de menu et choisir À la page ou

À la cellule.

Dans Draw et Impress
Une formule est insérée dans un dessin ou une diapositive comme objet OLE flottant et ne pos-
sède pas d’ancrage à une position particulière dans le dessin ou la diapositive.

Propriétés des objets formules
Les objets formules dans Calc, Draw et Impress peuvent être modifiés exactement comme tout
autre objet placé dans un classeur, un dessin ou une présentation, à l’exception de la taille et du
format du texte à l’intérieur de la formule. Pour plus d’information sur la manière de modifier les
propriétés des objets, voyez le Guide de Calc, le Guide de Draw ou le Guide d’Impress. Pour plus
d’informations sur la taille et le formatage du texte d’un objet formule, voyez le Guide de Math.

Les points suivants vous aideront à choisir la boîte de dialogue à utiliser pour modifier les proprié-
tés des objets formules.

• Pour l’arrière-plan des formules, utilisez les différentes options des pages de la boîte de
dialogue Remplissage.

• Pour les bordures des formules,  utilisez les différentes options de la boîte de dialogue
Ligne. Notez que les bordures des formules sont distinctes des bordures des cellules dans
un classeur de Calc.

• Pour positionner avec précision un objet formule, utilisez les différentes options des pages
de la boîte de dialogue Position et taille.

• Dans Draw et Impress, vous pouvez disposer, aligner, grouper, retourner, convertir, disso-
cier, combiner et éditer les points des objets formules.

• Vous ne pouvez pas modifier les attributs du texte d’un objet formule. Celui-ci est défini
quand vous créez la formule dans l’Éditeur de Formule.

• La taille d’un objet formule est définie par la taille de la police utilisée quand la formule est
créée dans l’Éditeur de Formule. Elle est protégée dans la boîte de  dialogue  Position et
taille mais vous pouvez décocher cette protection si vous le désirez. Ce n’est cependant
pas recommandé, car la modification de l’objet dans ce dialogue peut produire des distor-
sions qui rendront la formule difficile à lire.
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Des formules dans les diagrammes
Un diagramme dans un classeur de Calc est lui-même un objet OLE : vous ne pouvez donc pas
utiliser l’Éditeur de Formule pour créer et insérer une formule dans un diagramme.

Pour insérer une formule dans un diagramme, commencez par créer la formule grâce à l’Éditeur
de Formule et copiez-la dans le presse-papier. Créez ensuite le diagramme dans Calc et collez la
formule dans le diagramme. Elle est automatiquement convertie dans le format convenable pour
une insertion dans un diagramme.

Si vous désirez à un autre moment modifier la formule, vous devez répéter tout le processus de
création, copie et collage.
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